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ΠΕΡΙΛΗΨΗ 

 

 

    Στην παρούσα πτυχιακή εργασία με τίτλο «Μελέτη ροής αίματος σε πρότυπη 
αρτηρία με χρήση του υπολογιστικού προγράμματος ANSYS» παρουσιάζεται μία 
ρευστοδυναμική μελέτη σε πραγματική αρτηρία ενήλικου ανθρώπου για διάφορα είδη 
ροής. Ο σκοπός της συγκεκριμένης πτυχιακής είναι να γίνει η κατάλληλη 
μοντελοποίηση της αρτηρίας με χρήση εξελιγμένων υπολογιστικών πλεγμάτων και να 
εξαχθούν αποτελέσματα για διάφορα μεγέθη όπως πίεση, ταχύτητα ρευστού, τάσεις 
τοιχώματος κ.α. 

Στο πρώτο κεφάλαιο γίνεται μία σύντομη αναφορά στο ανθρώπινο 
καρδιαγγειακό σύστημα και τα βασικά χαρακτηριστικά και μεγέθη που το 
περιγράφουν με σκοπό να έχουμε μία πλήρη εικόνα του γενικότερου συστήματος 
που μελετάμε καθώς επίσης και μία μαθηματική προσέγγιση των εξισώσεων που 
χρησιμοποιεί το υπολογιστικό πακέτο Fluent για την μοντελοποίηση ροής μέσα από 
στένωση. 

Στο δεύτερο κεφάλαιο γίνεται αναγωγή του προβλήματος μοντελοποίησης 
πραγματικής αρτηρίας σε σωλήνα με στένωση στην μέση (vena contracta) για 
στρωτή ροή με σκοπό να κατανοήσουμε την λειτουργία του προγράμματος και τις 
δυνατότητες που μας παρέχει. Χρησιμοποιούμε ένα ολοκληρωμένο πακέτο 
λογισμικού Ansys Workbench, το οποίο περιλαμβάνει διάφορα εργαλεία για τον 
σχεδιασμό της γεωμετρίας, την δημιουργία υπολογιστικών πλεγμάτων καθώς επίσης 
και την επίλυση του προβλήματος της μοντελοποίησης και την παρουσίαση των 
αποτελεσμάτων. 

Στο τρίτο κεφάλαιο της παρούσας εργασίας προσομοιώνεται η παλμική ροή σε  
αρτηρία με χρήση δημιουργημένης συνάρτησης πίεσης για στρωτή χρησιμοποιώντας 
το εξελιγμένο λογισμικό ICEM CFD για την δημιουργία υπολογιστικού πλέγματος, 
έναν εμπορικό κώδικα Υπολογιστικής Ρευστοδυναμικής το Ansys Fluent για την 
επίλυση και το CFD-POST για την παρουσίαση των αποτελεσμάτων. 

Στο τέλος της πτυχιακής παρουσιάζονται τα συμπεράσματα των 
προσομοιώσεων και γίνεται μία συνολική σύγκριση των ροικών μοντέλων των 
αρτηριών. 

Αξίζει να σημειωθεί πώς πρόκειται για πραγματική αρτηρία ενός ενήλικου 
ανθρώπου και σε συνδυασμό με την χρήση παλμικής ροής έχουμε την δυνατότητα 
να εξάγουμε πολύ ικανοποιητικά αποτελέσματα για τα ρευστοδυναμικά 
χαρακτηριστικά του ανθρώπινου κυκλοφορικού συστήματος.  
  Η συγγραφή της πτυχιακής ακολουθεί την μορφή εγχειριδίου χρήσης, καθ’ όλη 
την διαδικασία σχεδιασμού της γεωμετρίας, τον ορισμό των παραμέτρων που 
χρειάζονται έως και την εξαγωγή των αποτελεσμάτων έχοντας ως στόχο να 
αποτελέσει βοήθεια για οποιονδήποτε αποφασίσει να ασχοληθεί με το συγκεκριμένο 
πρόγραμμα. 
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ΕΙΣΑΓΩΓΗ 

 

 

 

1. ΚΑΡ∆ΙΑΚΕΣ ΠΑΘΗΣΕΙΣ 

 

Οι καρδιακές παθήσεις αποτελούν μία από τις σημαντικότερες αιτίες θανάτου 
παγκοσμίως. Οι δύο βασικότερες αιτίες που οδηγούν σε καρδιακή ανεπάρκεια είναι η 
αρτηριοσκλήρυνση και το ανεύρυσμα και αποτελούν αντικείμενο μελέτης και έρευνας 
από μεγάλο πλήθος επιστημόνων. Αυτές ακριβώς οι παθήσεις και οι τεχνικές οι 
οποίες έχουν αναπτυχθεί για την αντιμετώπιση τους έχουν σαν αποτέλεσμα 
μεταβολές στην αιμοδυναμική συμπεριφορά του κυκλοφορικού συστήματος. Η 
οποιαδήποτε αλλαγή στην αιμοδυναμική μπορεί να επηρεάσει σε πολύ μεγάλο 
βαθμό την πορεία μίας πάθησης και να μεταβάλλει σημαντικά το είδος της τοπικής 
ροής του αίματος. Για αυτόν ακριβώς τον λόγο η μοντελοποίηση κρίνεται απαραίτητη 
για την μελέτη της αιμοδυναμικής συμπεριφοράς και την θεραπεία των αγγειακών 
νόσων.  

Η σύγχρονη τεχνολογική ανάπτυξη, η αύξηση της επεξεργαστικής ισχύς των 
υπολογιστών σε συνδυασμό με την δημιουργία νέων λογισμικών πακέτων παρέχουν 
στη σύγχρονη επιστήμη της μηχανικής τη δυνατότητα να αξιοποιήσει στο μέγιστο 
αυτά τα νέα εργαλεία. Η μελέτη της ροής σε στένωση αγωγού ειδικότερα αποτελεί 
ένα κλασικό πρόβλημα της ρευστομηχανικής.  

Σε αυτή τη πτυχιακή εργασία θα μελετήσουμε με τη βοήθεια ενός εμπορικού 
κώδικα Υπολογιστικής Ρευστοδυναμικής τη ροή διαμέσου μιας στένωσης αγωγού 
καθώς επίσης και τη ροή μέσω μιας ήπιας στένωσης ενός αγγείου για διαφορετικές 
περιπτώσεις ροής. Θα εξαχθούν αποτελέσματα για τα μεγέθη της ταχύτητας, της 
πίεσης καθώς επίσης και των διατμητικών τάσεων που εμφανίζονται στην κάθε 
γεωμετρία και θα γίνει σύγκριση και σχολιασμός των αποτελεσμάτων. Τέλος έγινε μία 
προσπάθεια η παρούσα πτυχιακή να αποτελέσει και ένα είδος “Εγχειριδίου Χρήσης” 
σε ότι αφορά την δημιουργία της συγκεκριμένης μοντελοποίησης, με σκοπό να 
βοηθήσει οποιονδήποτε θελήσει να ασχοληθεί με την υπολογιστική ρευστοδυναμική 
και το πρόγραμμα το οποίο θα χρησιμοποιήσουμε. 
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2. ΕΜΠΟΡΙΚΟ ΠΑΚΕΤΟ ΚΩ∆ΙΚΑ ΥΠΟΛΟΓΙΣΤΙΚΗΣ ΡΕΥΣΤΟ∆ΥΝΑΜΙΚΗΣ 
ANSYS FLUENT 

 

Το FLUENT είναι ο πιο διαδεδομένος εμπορικός κώδικας Υπολογιστικής 
Ρευστοδυναμικής (Computational Fluid Dynamics, CFD) γενικής χρήσης General-
Purpose Code). Το FLUENT επιλύει τις εξισώσεις Navier-Stokes που μπορούν να 
χαρακτηρίσουν κάθε είδους ροή ρευστών, μαζί με τις αντίστοιχες εξισώσεις 
μεταφοράς για την ενέργεια, συγκέντρωση χημικών ενώσεων, κλάσμα φάσης, κ.λπ., 
προσομοιώνοντας φυσικά φαινόμενα που συμβαίνουν ταυτόχρονα με τη ροή. 

Το FLUENT είναι κατασκευασμένο με τη μεθοδολογία των πεπερασμένων 
στοιχείων και υποστηρίζει μη-δομημένα (unstructured) πλέγματα όλων των τύπων. Η 
καταλληλότητα του και η ακρίβεια των υπολογισμών του έχει αποδειχθεί σε όλες τις 
περιοχές εφαρμογής του από τη δεκαετία του 1980, όταν και παρουσιάστηκε για 
πρώτη φορά. Σήμερα διαθέτει πάνω από 3000 βιομηχανικούς χρήστες παγκοσμίως, 
με τους αντίστοιχους ακαδημαϊκούς να υπολογίζονται σε πολλαπλάσιο μέγεθος.
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ΚΕΦΑΛΑΙΟ 1: ΑΝΑΤΟΜΙΑ ΤΟΥ ΚΑΡ∆ΙΑΓΓΕΙΑΚΟΥ 
ΣΥΣΤΗΜΑΤΟΣ 

 

 

 

1.1 ΓΕΝΙΚΕΣ ΕΝΝΟΙΕΣ ΚΑΙ ΟΡΙΣΜΟΙ ΜΕΓΕΘΩΝ 
 
 
1.1.1 Η καρδιά 

 
Η καρδιά είναι ένα μυώδες όργανο το οποίο αποτελείται από δυο 

συγχρονισμένες αντλίες σε παραλληλία:  
 τη δεξιά πλευρά, η οποία συλλέγει το αποξυγονωμένο αίμα από τις φλέβες της 
συστηματικής κυκλοφορίας και αιματώνει τους πνεύμονες και  
 την αριστερή πλευρά η οποία συλλέγει το αίμα το οποίο έχει οξυγονωθεί από 
τις πνευμονικές φλέβες και ανατροφοδοτεί το υπόλοιπο σώμα. 
  

 

Εικόνα 1.1: Η ανατομία της καρδιάς [1] 
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Κατά τη βασική της λειτουργία η καρδιά πάλλεται με ρυθμό τροφοδοτώντας το 
υπόλοιπο σώμα με αίμα με την βοήθεια του κυκλοφορικού συστήματος. Ειδικότερα η 
λειτουργία της καρδιάς συνίσταται σε δύο διακριτές περιόδους:  

 την συστολή του καρδιακού μυϊκού ιστού 
 την διαστολή του καρδιακού μυϊκού ιστού 

Στη συστολική φάση της καρδιάς οι κόλποι προωθούν το αίμα στις κοιλίες, 
έπειτα το οξυγονωμένο αίμα προωθείται από τους πνεύμονες στον αριστερό κόλπο 
και από εκεί στην αριστερή κοιλία. 

Στην φάση της διαστολής οι κοιλίες  χαλαρώνουν για να εισέλθει το αίμα που 
έρχεται από τους κόλπους.  

Η χρονική περίοδος από το τέλος μιας συστολής έως και το τέλος της 
επόμενης ονομάζεται καρδιακός κύκλος ή καρδιακός παλμός. 

 

 

1.1.2 Κυκλοφορικό σύστημα 

 

Το κυκλοφορικό σύστημα είναι στην ουσία ένα σύνολο αγωγών μεταφοράς 
του αίματος και χωρίζεται σε δύο υποσυστήματα. 

 Στη μεγάλη κυκλοφορία όπου το πλούσια οξυγονωμένο αίμα ρέει από το 
αριστερό μέρος της καρδιάς και τροφοδοτεί το υπόλοιπο σώμα και 
 Στη μικρή κυκλοφορία όπου το αίμα έχει επιστρέψει στο δεξί μέρος  της 
καρδιάς και προωθείται προς τους πνεύμονες για να οξυγονωθεί και πάλι. 

Τα αγγεία που ξεκινούν με την σειρά τους από την αριστερή κοιλία είναι: η 
αορτή, οι κύριες αρτηρίες, τα αρτηρίδια, το τριχοειδικό σύστημα, τα φλεβίδια, και 
σταδιακά μεγαλύτερες φλέβες που καταλήγουν στο δεξί τμήμα της καρδιάς. 

Η κατανομή του αίματος στο κυκλοφορικό σύστημα είναι η εξής: 

 1 L στις αρτηρίες 
 3,5 L στις φλέβες της μεγάλης κυκλοφορίας  
 0,5 L βρίσκονται στις αρτηρίες και φλέβες της μικρής κυκλοφορίας. 

 

 

1.1.3 Ιδιότητες του αίματος 

 

Το αίμα είναι ένα μη-νευτώνιο ρευστό και αποτελείται από πλάσμα, ερυθρά 
αιμοσφαίρια (5 εκατομμύρια/݉݉ଷ) που αποτελούν το 45% του συνολικού όγκου του 
αίματος, τα  λευκά αιμοσφαίρια (0,30% του συνολικού όγκου του αίματος) και τα 
αιμοπετάλια που αποτελούν το 0,15% του συνολικού όγκου. 
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Γενικότερα το αίμα δεν έχει σταθερή πυκνότητα ή ιξώδες αλλά εξαρτώνται από 
πολλούς παράγοντες όπως για παράδειγμα η ηλικία, η διατροφή, κάποια μορφή 
αγγειακής πάθησης κ.α.. Μία μέση τιμή για την πυκνότητα και το ιξώδες όπου θα 
χρησιμοποιήσουμε και για τις μοντελοποιήσεις μας είναι: 

 Πυκνότητα1050 kg/݉ଷ 
 Ιξώδες0.004 kg/(ms) 

Ένα ακόμα σημαντικό χαρακτηριστικό του αίματος είναι ο βαθμός ολισθηρότητας 
ή αλλιώς γλοιότητα μεταξύ δύο γειτονικών στρωμάτων ρευστού. Παρακάτω 
παρουσιάζεται ένα διάγραμμα συντελεστή γλοιότητας συναρτήσει του αιματοκρίτη. 

 

 

∆ιάγραμμα 1.1: Συντελεστής γλοιότητας συναρτήσει του αιματοκρίτη [7] 

 

 

1.1.4 Αρτηριακή πίεση 

 

Η αρτηριακή πίεση αντιπροσωπεύει τη δυναμική διαδικασία της συστολής και 
διαστολής της καρδιάς και της παροχής του αίματος στο αρτηριακό σύστημα. 
Ουσιαστικά αναφέρεται στην πίεση που εξασκεί το αίμα σε κάθε μονάδα επιφάνειας 
των αγγειακών τοιχωμάτων. Συνεπώς είναι αποτέλεσμα δύο δυνάμεων, της κοιλιακής 
συστολής και της αντίστασης των αρτηριών στη ροή του αίματος μέσα σε αυτές. 
Παρακάτω παρουσιάζεται ένα διάγραμμα της αρτηριακής πίεσης κατά την διάρκεια 
ενός καρδιακού κύκλου. 
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∆ιάγραμμα 1.2: ∆ιάγραμμα αρτηριακής πίεσης κατά την διάρκεια ενός καρδιακού 
κύκλου [3] 

 

1.1.5 Ταχύτητα του αίματος 

 

Στο παρακάτω ποιοτικό διάγραμμα παρουσιάζεται η ταχύτητα ροής του 
αίματος και η συνολική επιφάνεια διατομής των αγγείων στις διάφορες περιοχές του 
κυκλοφορικού συστήματος. Η ταχύτητα στην πραγματικότητα δεν είναι συνεχής αλλά 
έχει παλμική φύση με συχνότητα 1 Hz. Όπως παρατηρούμε στο διάγραμμα η 
ταχύτητα είναι αντιστρόφως ανάλογη του εμβαδού  της διατομής αυτής, κάτι το οποίο 
επαληθεύεται και από τον νόμο της συνέχειας. 

 

 

∆ιάγραμμα 1.3: Ταχύτητα ροής του αίματος και συνολική επιφάνεια διατομής των 
αγγείων στις διάφορες περιοχές του κυκλοφορικού συστήματος [7] 
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1.2  ΜΑΘΗΜΑΤΙΚΗ ΠΡΟΣΕΓΓΙΣΗ ΤΟΥ ΦΑΙΝΟΜΕΝΟΥ ΤΗΣ ΡΟΗΣ ΜΕΣΑ ΑΠΟ 
ΣΤΕΝΩΣΗ ΣΕ ΑΡΤΗΡΙΑ 

 

Το Fluent έχει την δυνατότητα να επιλύσει διάφορες εξισώσεις όπως  την 
εξίσωση διατήρησης της ορμής, διατήρησης της μάζας, διατήρησης της ενέργειας, 
όταν υπάρχει θερμική μεταφορά με την ροή, συμπιεστότητα των ρευστών, ανάμειξη 
στοιχείων, ή τυρβώδη ροή. Παρακάτω παρουσιάζονται συνοπτικά οι βασικότερες 
εξισώσεις τις οποίες χρησιμοποιεί το Fluent για την επίλυση των συγκεκριμένων 
μοντελοποιήσεων που θα πραγματοποιήσουμε. 

 

 

1.2.1 Εξίσωση διατήρησης της μάζας 

 

Η γενικότερη μορφή της εξίσωσης για την διατήρηση της μάζας ή εξίσωση 
συνέχειας, μπορεί να γραφτεί ως εξής:  

 ܵ௠ = డఘడ௧+∇ ∙ ߩ) ∙  ሬԦ)            (1.1)ݑ

 

Ο όρος ܵ௠ πηγής (source mass) αντιπροσωπεύει κάποια πηγή μεγέθους. 
Στην περίπτωση των συγκεκριμένων μοντελοποιήσεων που θα πραγματοποιήσουμε 
εμείς δεν υπάρχει κάποια πηγή οπότε θέτουμε ܵ௠=0 και η εξίσωση της συνέχειας 
παίρνει τη μορφή: 

 డఘడ௧+݀݅ߩ)ݒ ∙  ሬԦ)=0        (1.2)ݑ

 
 
1.2.2 Εξίσωση ∆ιατήρησης της Ορμής 
 
 డడ௧ ߩ) ∙ (ሬԦݑ + ∇ ∙ ݌∇-=(ሬԦݑሬԦݑߩ) + ∇(߬̿) + ߩ Ԧ݃+ܨԦ     (1.3) 

 

Όπου: ݌: Στατική πίεση ߬̿: Τανυστής τάσης ߩ Ԧ݃: ∆ύναμη λόγω βαρύτητας (ανά μονάδα όγκου) 
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 Ԧ: Εξωτερική δύναμη (ανά μονάδα όγκου)ܨ

Η δύναμη ܨԦ μπορεί να περιέχει και επιπλέον εξαρτώμενους παράγοντες 
ορισμένους από τον χρήστη. 

Ο τανυστής τάσης ߬̿ δίνεται από την σχέση: 

 ߬̿ = ߤ ቂ(∇ݑሬԦ + (ሬԦ்ݑ∇) − ଶଷ ∇ ∙  ቃ̿      (1.4)ܫሬԦݑ

 

Όπου: 

μ: Μοριακό ιξώδες ܫ:̿ Μοναδιαίος τανυστής 
 

 

1.2.3 Εξισώσεις ταχύτητας στη μόνιμη και μη μόνιμη ροή  
 

Η ταχύτητα εισόδου για μόνιμη ροή με παραβολικό προφίλ ταχύτητας σε 
αγωγό κυκλικής διατομής δίνεται από την σχέση: 

௜ݑ  = ത(1ݑ2 − ௥మோమ)        (1.5) 

 

Και η μέγιστη τιμή της ταχύτητας προκύπτει για r=0 

 uஜέஓங஢த஗ = 2uത ቀ1 − ଴ୖమቁ = 2uത       (1.6) 

 

Όπου: ݑ௜: Η ταχύτητα εισόδου στην αρτηρία ݑത: Η μέση ταχύτητα στη διατομή 

R: Η ακτίνα της διατομής 

r: Η μεταβλητή ακτίνα της διατομής 
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Η ταχύτητα εισόδου για μη μόνιμη ροή θα δίνεται από τη σχέση: 

௜ݑ  = (1	ത௠ݑ4 − ௥మோమ)݊݅ݏଶ(π ௧்
)       (1.7) 

 

Η παραπάνω σχέση προκύπτει από την χρονικά μεταβαλλόμενη μέση 
ταχύτητα της οποίας ο τύπος είναι: 

തݑ  = ଶ(π݊݅ݏ	ത௠ݑ2 ௧்
)        (1.8) 

 

Όπου: 	ݑത௠	: Η χρονικά μέση τιμή ταχύτητας στην περίοδο Τ 

 t: Χρονική στιγμή 

 
 
1.2.4 Εξισώσεις παροχής  

 

Η ογκομετρική παροχή που διαρρέει την αρτηρία δίνεται ύστερα από 
ολοκλήρωση της κατανομής ταχυτήτων στην διατομή S: 

 

Q=׬ ௌ	ሬԦݑ ∙ ሬ݊Ԧ ∙ ݀ܵ 					ௗௌୀଶగ௥ௗ௥								ሱۛ ۛۛ ۛۛ ۛۛ ۛۛ ۛሮQ=׬ ݑ ∙ 2 ∙ ߨ ∙ ݎ ∙ ோ଴ݎ݀     (1.9) 

 

Αντίστοιχα η χρονικά μεταβαλλόμενη παροχή δίνεται από τον τύπο: 

 

Q(t)=2ߨ	ܴଶ ∙ ത௠ݑ ∙ ଶ(π݊݅ݏ ௧்
)       (1.10) 

 

Τέλος η χρονικά μέση παροχή στην περίοδο είναι: 

 ܳ௠=π∙ ܴଶ ∙  ത௠        (1.11)ݑ
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1.2.5 ∆ιατμητική τάση 

 

Η διατμητική τάση εκφράζει την εφαπτόμενη δύναμη στα τοιχώματα ανα 
μονάδα επιφάνειας που ασκείται από το ρευστό και έχει μονάδες Πασκάλ( Ρα). 

Η σχέση που την περιγράφει είναι: 
 ߬௪=

ௗிೞௗ஺           (1.13) 

 

Όπου  ݀ܨ௦: απειροστή δύναμη που ασκείται εφαπτομενικά στο απειροστό στοιχείο της 
επιφάνειας. ݀஺:Απειροστό στοιχείο επιφάνειας ߬௪:∆ιατμητική τάση 
Το μέτρο της διατμητικής τάσης εκφράζεται από την παρακάτω  σχέση: 
 ߬௪=μௗ௨ௗ௥         (1.14) 

 

Όπου μ: δυναμική συνεκτικότητα  ݀ݑ :η μεταβολή της ταχύτητας του ρευστού στον αγωγό 
  .απόσταση τοιχώματος από το κέντρο του αγωγού:ݎ݀ 
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ΚΕΦΑΛΑΙΟ 2: ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΜΟΝΙΜΗΣ ΚΑΙ 
ΣΤΑΘΕΡΗΣ ΡΟΗΣ ΣΕ ΑΓΩΓΟ ΚΥΚΛΙΚΗΣ ∆ΙΑΤΟΜΗΣ 

 

 

 

2.1 ΣΚΟΠΟΣ 

 

Σκοπός της συγκεκριμένης μοντελοποίησης είναι αρχικά να μπορέσουμε να 
μπούμε στην γενικότερη φιλοσοφία της προσομοίωσης ροής σε αγωγούς και να 
καταλάβουμε τους μηχανισμούς με τους οποίους λειτουργεί το λογισμικό. 
Επιπρόσθετα να κάνουμε μία πρώτη προσέγγιση μίας αρτηριακής γεωμετρίας όπου 
τα αποτελέσματα της μοντελοποίησης θα τα χρησιμοποιήσουμε για να εξάγουμε 
κάποια συμπεράσματα σε συνδυασμό με τα αποτελέσματα του μοντέλου μίας 
πραγματικής αρτηρίας που θα μοντελοποιήσουμε στο κεφάλαιο 3. 

Για την μοντελοποίηση της γεωμετρίας μας και την επίλυση του συγκεκριμένου 
προβλήματος θα χρησιμοποιήσουμε το λογισμικό Ansys workbench. Η πλατφόρμα 
διεπαφής (interface) του Ansys workbench παρουσιάζεται παρακάτω και στην ουσία 
μας δίνει την δυνατότητα να επιλέξουμε κάποια έτοιμα συστήματα προγραμμάτων για 
την εκάστοτε μοντελοποίηση. Το κάθε σύστημα το παρουσιάζει είτε μεμονωμένα, είτε 
σε συνδυασμό με οποιαδήποτε άλλη διεργασία θέλουμε να συμπεριλάβουμε στην 
μελέτη μας. Στην προκειμένη περίπτωση θα χρησιμοποιήσουμε το σύστημα Fluid 
Flow (Fluent) ως μεμονωμένο σύστημα. 

 

 

2.2 ΓΕΝΙΚΟΤΕΡΑ ΒΗΜΑΤΑ ΚΑΤΑΣΚΕΥΗΣ ΓΕΩΜΕΤΡΙΑΣ ΚΑΙ 
ΑΡΙΘΜΗΤΙΚΟΥ ΠΛΕΓΜΑΤΟΣ 

 

Η διαδικασία κατασκευής της γεωμετρίας, του αριθμητικού πλέγματος και του 
ορισμού οριακών τύπων είναι η εξής: 

1. Περιγραφή του προβλήματος. 
2. Ορισμός στρατηγικής και κατασκευή γεωμετρίας. 
4. ∆ημιουργία πλέγματος. 
5. Έλεγχος ποιότητας πλέγματος 
6. Ορισμός οριακών τύπων. 
7. Εξαγωγή αρχείου και είσοδος στο Fluent. 
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2.3 ΣΧΕ∆ΙΑΣΜΟΣ ΑΡΤΗΡΙΑΣ ΜΕ ΣΤΕΝΩΣΗ 
 

Το πρόβλημα που θέλουμε να μοντελοποιήσουμε είναι η ροή του αίματος 
μέσα από μία αρτηρία με στένωση (vena contracta). 

Θεωρούμε την αρτηρία σαν ένα κυλινδρικό αγωγό σταθερής διατομής στα 
άκρα του, με στένωση στο κέντρο του. To αίμα εισέρχεται από την αριστερή διατομή 
της αρτηρίας, περνάει μέσα από την περιοχή της στένωσης και έπειτα εξέρχεται από 
την αριστερή διατομή της αρτηρίας. 

Για να αποφύγουμε έντονα φαινόμενα αναστροφής της ροής, κατασκευάζουμε 
το γεωμετρικό μας μοντέλο σε μεγαλύτερο μήκος έτσι ώστε να έχει προλάβει η ροή 
να διαμορφωθεί πριν και μετά τη στένωση. 
 
Βήμα 1: Εκκίνηση του Ansys workbenchΕπιλογή συστήματος Fluid Flow (Fluent). 
 

 

Εικόνα 2.1: Πλατφόρμα διεπαφής Ansys workbench 
 
Βήμα 2: Λογισμικό Design modeler. 

 
Στο δεύτερο βήμα της μοντελοποίησης μας θα χρησιμοποιήσουμε το 

λογισμικό Design modeler για την κατασκευή της γεωμετρίας. Οπότε επιλέγουμε από 
το σύστημαGeometryOpen. 

Η αρχική πλατφόρμα διεπαφής παρουσιάζεται στην παρακάτω εικόνα: 
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Εικόνα 2.2: Πλατφόρμα διεπαφής Ansys Design 

 
Βήμα 3: Σχεδιασμός γεωμετρίας. 

 
Για λόγους ευκολίας επιλέγουμε να σχεδιάσουμε  στο σύστημα αξόνων με 

άξονα κύριας ροής v.Το σύστημα v,w,x είναι ένα τοπικό σύστημα αξόνων που 
ορίσαμε πάνω στην άξονα x της κύριας ροής για διευκόλυνση μας. 

Έπειτα χρησιμοποιώντας τα σχεδιαστικά εργαλεία που είναι διαθέσιμα στην 
καρτέλα Sketching αρχίζουμε να δημιουργούμε την γεωμετρία μας. Όπως αναφέραμε 
παραπάνω η γεωμετρία θα αποτελείται από δύο κυλινδρικά μέρη στα άκρα της και 
στο κέντρο μία στένωση (vena contracta). 

Στην εικόνα φαίνεται το αρχικό σχέδιο δύο διαστάσεων της γεωμετρίας με  τις 
ξεχωριστές γραμμές από τις οποίες αποτελείται. Κάθε τμήμα έχει λάβει ένα γράμμα 
ως δείκτη για να μπορούμε αργότερα να τροποποιήσουμε με ευκολία τις διαστάσεις 
του αλλά και να είναι ευκολότερη η αναφορά σε αυτό. 

 

 

Εικόνα 2.3: 2D Σχέδιο γεωμετρίας με τις διαστάσεις 
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Αφού λοιπόν έχουμε δημιουργήσει 2D σχέδιο,πρέπει τώρα να το μετατρέψουμε σε 
3D. Αυτό γίνεται με την λειτουργεία «Revolve» στις επιλογές «Sketching». 
Επιλέγουμε αρχικά το σχέδιο, έπειτα τον άξονα γύρω από τον οποίο θα 
περιστρέψουμε την γεωμετρία και τέλος πατάμε «Revolve». Στην εικόνα 2.4 
παρουσιάζεται το αποτέλεσμα. 

 

Εικόνα 2.4: 3D σχέδιο γεωμετρίας με τις διαστάσεις 

 

 

Εικόνα 2.5:  3D σχέδιο γεωμετρίας με τις διαστάσεις και τον δημιουργημένο όγκο 

 

Αφού λοιπόν έχουμε δημιουργήσει την γεωμετρία μας τώρα είμαστε έτοιμοι να 
δημιουργήσουμε ένα πλέγμα (mesh). 
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2.4 ∆ΗΜΙΟΥΡΓΙΑ ΥΠΟΛΟΓΙΣΤΙΚΟΥ ΠΛΕΓΜΑΤΟΣ 

 

Βήμα 4: ∆ημιουργία πλέγματος 

Όπως αναφέραμε και στην εισαγωγή το FLUENT είναι κατασκευασμένο με τη 
μεθοδολογία των πεπερασμένων όγκων και υποστηρίζει μη-δομημένα (unstructured) 
πλέγματα όλων των τύπων. Απαραίτητο στοιχείο της εφαρμογής της μεθόδου 
Πεπερασμένων Στοιχείων είναι η διακριτοποίηση του μέσου σε στοιχεία (elements) 
με τη βοήθεια ιδεατών επιφανειών. Τα τμήματα αυτά αποτελούνται από δύο ή 
περισσότερους κόμβους οι οποίοι συνδέονται με ευθύγραμμα ή καμπύλα τμήματα. Οι 
κορυφές των στοιχείων ορίζουν τους κόμβους (nodes) του πλέγματος (grid-mesh). 

Κάποιες χαρακτηριστικές μορφές στοιχείων είναι τα μονοδιάστατα ή γραμμικά, 
τα τριγωνικά και ορθογωνικά ή γενικότερα τετραπλευρικά σε δύο διαστάσεις, 
πυραμιδοειδή και πρισματικά. Γενικότερα ισχύει ότι οι απλούστερες μορφές στοιχείων 
είναι αυτές που έχουν το εξής χαρακτηριστικό: ο αριθμός των κόμβων του στοιχείου 
είναι ίσος με τον αριθμό των πλευρών του στοιχείου. 

 

 

Εικόνα 2.6: 3D Σχέδιο γεωμετρίας με το δημιουργημένο πλέγμα 

 

Παρακάτω φαίνεται πώς διαμορφώθηκε το πλέγμα στην επιφάνεια της 
εισόδου (inlet) του ρευστού και της εξόδου (outlet). Καθότι μας ενδιαφέρει η 
συμπεριφορά των μεγεθών που μελετάμε περισσότερο στην στένωση του αγωγού 
και όχι τόσο στην είσοδο ή στην έξοδο του, το πλέγμα εδώ είναι πιο αραιό με 
μεγαλύτερα στοιχεία. 
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Εικόνα 2.7: ∆ιαμόρφωση υπολογιστικού πλέγματος στην είσοδο του ρευστού 

Αντίστοιχη διαμόρφωση έχουμε και στην επιφάνεια εξόδου του 
ρευστού(outlet): 

 

 

Εικόνα 2.8: ∆ιαμόρφωση υπολογιστικού πλέγματος στην έξοδο του ρευστού
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2.5 ΕΙΣΑΓΩΓΗ ΜΟΝΤΕΛΟΥ ΣΤΟ FLUENT 

 

Βήμα 5: Εισαγωγή της γεωμετρίας και του πλέγματος για ανάλυση στο Fluent 

Έχοντας ολοκληρώσει την δημιουργία του πλέγματος στο γεωμετρικό μας 
μοντέλο μπορούμε να προχωρήσουμε με την επίλυση του προβλήματος. Σε αυτό το 
στάδιο θα μοντελοποιηθεί η μόνιμη ροή αίματος σε κυλινδρικό σωλήνα με στένωση 
στην μέση, μέσω του λογισμικού πακέτου Fluent. Χρησιμοποιώντας την Μέθοδο 
Πεπερασμένων Στοιχείων, το Fluent υπολογίζει τα άγνωστα μεγέθη στους κόμβους οι 
οποίοι δημιουργούνται από τη διαίρεση του πεδίου σε στοιχεία. Έπειτα με τη 
θεώρηση κατάλληλων συναρτήσεων και με τη χρήση των παραμέτρων που του 
έχουμε ορίσει γίνεται η σύνδεση της κατανομής των μεγεθών στα εσωτερικά σημεία 
κάθε στοιχείου. Έτσι λοιπόν είναι δυνατόν να υπολογιστεί η τιμή των μεγεθών αυτών 
σε κάθε σημείο του πεδίου με τους κόμβους του στοιχείο αυτού. 

Τα γενικότερα βήματα τα οποία θα ακολουθήσουμε είναι: 
Α. Εισαγωγή του αρχείου στο Fluent 
Β. Έλεγχος του πλέγματος 
Γ. Ορισμός μοντέλου 
∆. Καθορισμός ιδιοτήτων ρευστού και αγωγού 
Ε. Παραμετροποίηση των συνθηκών λειτουργίας  
Ζ. Ορισμός οριακών συνθηκών 
Η. Επίλυση του προβλήματος 
Θ. Αποτελέσματα 
 

Βήμα 5.1: Εισαγωγή του αρχείου πλέγματος mesh (.msh) στο Fluent 

File>Read>Case... 

 

Βήμα 5.2: Έλεγχος επιτυχούς εισαγωγής πλέγματος 

Κάνουμε έλεγχο για να διαπιστώσουμε ότι η εισαγωγή του πλέγματος στο 
Fluent ήταν επιτυχημένη. 
Mesh>Info>Size… 
 

 

Εικόνα 2.9: Ελεγχος του πλέγματος και στατιστικά στοιχεία 
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Η εισαγωγή του πλέγματος ήταν επιτυχημένη και το Fluent μας εμφανίζει και 
τα στατιστικά στοιχεία της γεωμετρίας μας όπως συνολικό αριθμό 
κόμβων,όγκο,εμβαδό επιφανειών κ.α.. όπως παρουσιάζονται στην εικόνα 2.9 

 

Βήμα 5.3: Καθορισμός κλίμακος πλέγματος 

Μία σημαντική παράμετρος που πρέπει να ληφθεί υπόψη είναι η κλίμακα του 
πλέγματος. Στην εικόνα που ακολουθεί παρουσιάζονται οι χωρικές μονάδες που 
χρησιμοποιούμε στο πλέγμα, η κλίμακα που χρησιμοποιείται στις 3 διαστάσεις x,y,z 
καθώς επίσης και οι οριακές διαστάσεις του γεωμετρικού μοντέλου. 

 

 

Εικόνα 2.10: Κλίμακα πλέγματος 

Επιπρόσθετα θα διευκρινήσουμε τις μονάδες σε mm για αποφυγή κάποιου 
σφάλματος στις εκάστοτε μετατροπές που μπορεί να προκύψουν σε μετέπειτα 
βήματα. 
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Βήμα 5.4: Εμφάνιση πλέγματος 

 

 

Εικόνα 2.11: Μορφοποίηση απεικόνισης πλέγματος 

 
Στο παράθυρο Mesh Display μπορούμε να επιλέξουμε να μας εμφανίζει το 

πλέγμα που έχουμε δημιουργήσει συνολικά ή για κάθε επιφάνεια ξεχωριστά. 
Επιπλέον παρέχει τη δυνατότητα να μορφοποιήσουμε τα χαρακτηριστικά της 
απεικόνισής του. Οπότε επιλέγουμε τι θέλουμε να μας εμφανίσει, έπειτα ποια 
επιφάνεια και τέλος πατάμε Display. 

 

 

Εικόνα 2.12: Συνολική απεικόνιση πλέγματος 
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Βήμα 6: Ορισμός Λύτη μοντέλου(Solver) 

Σε αυτό το βήμα επιλέγουμε τον τύπο του λύτη για τη μοντελοποίηση της 
γεωμετρίας μας. Υπάρχουν δύο τύποι λυτών στο Fluent. Ο ένας επιλύει 
χρησιμοποιώντας αλγόριθμους με βάση την πίεση και εφαρμόζονται κατά προτίμηση 
στις επιλύσεις ρευστοδυναμικών μοντέλων λόγω της ευελιξίας που διαθέτουν και της 
υψηλής ταχύτητας τους, και ο δεύτερος τύπος χρησιμοποιεί αλγόριθμους με βάση 
την πυκνότητα και εφαρμόζεται κυρίως σε  συμπιεστές ροές πολύ υψηλών 
ταχυτήτων. 

Ο τύπος λύτη που θα χρησιμοποιήσουμε θα έχει ως βάση την πίεση. 
Επιπρόσθετα θα γίνει η επιλογή για σταθερό χρόνο διότι η ροή είναι μόνιμη. 

 

 

Εικόνα 2.13: Ορισμός Λύτη 
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Βήμα 7: Καθορισμός ιδιοτήτων ρευστού και αγωγού 

 

 

Εικόνα 2.14: Εισαγωγή ιδιοτήτων ρευστού 

 

Η επιλογή των τιμών ιξώδους και πυκνότητας του αίματος στην παρούσα 
εργασία γίνεται για ενήλικο άνθρωπο βάση των “in, vivo” μετρήσεων όπως 
αναφέρονται στη μελέτη των Siouffi, M., Pelissier, R., Farahifar, D., Rieu, R. [12]. 

Οπότε θέτουμε για την πυκνότητα και το μοριακό ιξώδες, αντίστοιχα: 

Density: 1050 kg/݉ଷ 
Viscosity: 0.004 kg/(ms) 

Για το υλικό του αγωγού θα θεωρήσουμε ότι δεν έχει ελαστικότητα και 
δεδομένου ότι δεν θα μελετηθεί περαιτέρω στην εξομοίωση σε άλλες διεργασίες 
(όπως θερμότητα), χρησιμοποιήθηκε η προεπιλεγμένη επιλογή του αλουμινίου. 

Density: 2719 kg/݉ଷ 
 

Βήμα 8: Ορισμός οριακών συνθηκών(Boundary Conditions) 

Σε αυτό το βήμα θα ορίσουμε τις συνοριακές συνθήκες για κάθε ζώνη της 
γεωμετρίας μας. 

Με τον όρο οριακή οριακή συνθήκη ορίζουμε τα μέρη εκείνα από τα οποία τα 
αποτελείται η γεωμετρία μας, τα χαρακτηριστικά τους και τις ιδιότητες αυτών. 

 



22 
 

Βήμα 9: Είσοδος αγωγού (Inlet) 

 

 

Εικόνα 2.15: Οριακές συνθήκες για είσοδο 

 

Οι οριακές  συνθήκες που έχουμε ορίσει για τη συγκεκριμένη περίπτωση είναι 
4: 

1. Inlet (Είσοδος) 
2. Interior – Solid (Εσωτερική περιοχή ροής) 
3. Outlet (Έξοδος) 
4. Wall – Solid (Τοίχωμα) 

Εισάγουμε την ταχύτητα του ρευστού σε αυτό το σημείο. Λόγω της δυσκολίας 
που παρουσιάζει η in vivo μέτρηση της ταχύτητας του αίματος τα περισσότερα 
πειράματα έχουν διεξαχθεί in vitro με μεθόδους όπως η ανεμομετρία Laser Doppler 
και η ταχυμετρία υπερήχων (Ultrasonic Velocimetry). Μια σχετικά νέα μέθοδος για 
την μέτρηση της ταχύτητας σε μικροκανάλια είναι η μ-PIV, που αποτελεί μια μη 
παρεμβατική μέθοδο για τη μέτρηση δισδιάστατων πεδίων ταχύτητας και έχει 
χρησιμοποιηθεί με επιτυχία για τη μελέτη βιολογικών συστημάτων. Η ταχύτητα έχει 
οριστεί ως velocity:0.55 m/sec που αντιστοιχεί στην μέση τιμή της ταχύτητας του 
αίματος σε έναν ενήλικο ανθρωπο. Η τιμή της ταχύτητας ορίστηκε βάση των 
μετρήσεων που έγιναν στο νοσοκομείο Παίδων Αγία Σοφία και αναφέρονται στην 
μεταπτυχιακή διπλωματική εργασία της Πανωρέα Γ. Μπάκα (σελ:39-42) [4] και στις 
«Σημειώσεις Εργαστηρίου Μηχανικής Ρευστών» της Ιατρικής Φυσικής του 
Πανεπιστημίου Αθηνών [10].  
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Από τον τύπο: 
 

Re=
௨ഥ∙ௗఓ  (2.1)         ߩ

 
Εάν θέσω όπου d=0.01 m και ρ=1050 kg/݉ଷ και μ=0.004 kg/m-s τότε 

προκύπτει ότι: 
തݑ  = ୖୣଶ଺ଶହ		 m/s         (2.2) 

 
Αντικαθιστώντας ݑത =0.55 m/s έχουμε: 

Re=1443.7 =1444 
 

Θεωρώντας ότι για αριθμούς Reynolds<2000 έχουμε στρωτή ροή οπότε 
επαληθεύουμε ότι οι παράμετροι που έχουμε ορίσει μέχρι στιγμής είναι σωστοί. 

 

 

∆ιάγραμμα 2.1: ∆ιάγραμμα Moody 

 

 

Εικόνα 2.16: Εισαγωγή ταχύτητας ρευστού 
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Βήμα 10: Έξοδος Ρευστού(Outlet) 

Σε αυτό το βήμα θα ορίσουμε την οριακή συνθήκη στην έξοδο του ρευστού. 
Οπότε επιλέγουμε Outlet>Pressure outlet>OK 
 

 

Εικόνα 2.17: Πίεση εξόδου 

 

Βήμα 11: Τοίχωμα (Wall) 

 

Εικόνα 2.18: Εισαγωγή ιδιοτήτων τοιχώματος 

 

Σε αυτό το βήμα επιλέγουμε τις οριακές συνθήκες του τοιχώματος της 
γεωμετρίας μας. Επιλέγουμε σταθερό τοίχωμα διότι δεν έχουμε κινήσεις του 
τοιχώματος σε κάποιον άξονα και ισόθερμο διότι δεν μελετάμε την συμπεριφορά του 
αγωγού σε μεταβολές της θερμοκρασίας. 

 

Βήμα 12: Εισαγωγή αρχικών συνθηκών 

Σε αυτό το βήμα κάνουμε αρχικοποίηση του λύτη. Αυτό σημαίνει πως θέτουμε 
αρχικές τιμές, όπως π.χ. την ταχύτητα του ρευστού στον τοπικό άξονα συμμετρίας v 
και επιδιώκουμε την επίλυση από την είσοδο της γεωμετρίας. 
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Εικόνα 2.19: Αρχικοποίηση Λύτη 

 

Βήμα 13: Θέτουμε τις προεπιλεγμένες παραμέτρους λύσης  

Στην συγκεκριμένη μοντελοποίηση χρησιμοποιήσαμε λύτη με βάση την 
πίεση.Αυτό το είδος λύτη χρησιμοποιεί κάποιες παραμέτρους λύσης (under 
relaxation factors) για να επιλύσουν τις απαραίτητες εξισώσεις.Οι προεπιλεγμένες 
τιμές των παραμέτρων αυτών επιλέγονται από το Fluent  με δυνατότητα 
τροποποίησης από τον χρήστη. 
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Εικόνα 2.20: Ορισμός παραμέτρων λύτη 

 

Βήμα 14: Καθορισμός κριτηρίου σύγκλισης (Convergence criteria) 

 

Εικόνα 2.21: Ορισμός κριτηρίου σύγκλισης 
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2.6 ΕΠΙΛΥΣΗ 

 

Βήμα 15: Επίλυση 

Ενας σημαντικός παράγοντας που επηρεάζει την επίλυση της αριθμητικής 
μεθόδου είναι ο συνολικός αριθμός υπολογιστικών επαναλήψεων που θα 
εκτελεστούν. Παρακάτω δίνεται μία επεξήγηση των βασικότερων επιλογών που 
μπορούν να μεταβληθούν στο πρόγραμμα. 

1. Time Step Size: Ορισμός διάρκειας χρονικού βήματος 

2. Number of Time Steps: Ορισμός πλήθους χρονικών βημάτων 

3. Max Iteration per Time Step: Μέγιστος αριθμός επαναλήψεων ανά χρονικό 
 βήμα 

Σε περιπτώσεις μοντελοποίησησς ροής η επιλογή χρονικού βήματος έχει πολύ 
μεγάλη σημασία διότι έχει παρατηρηθεί ότι όσο μικρότερο είναι το βήμα τόσο πιο 
σταθερή λύση έχουμε και η μέθοδος συγκλίνει πιο εύκολα αλλά απαιτείται πολύ 
μεγάλη υπολογιστική ισχύς. 

Στην δική μας περίπτωση θα θέσουμε 1000 επαναλήψεις οι οποίες είναι 
αρκετές για να έχουμε μια ικανοποιητική λύση. 

 

 

Εικόνα 2.22: Ορισμός υπολογιστικών χαρακτηριστικών 

 

Η λύση μας φαίνεται να συγκλίνει αλλά πρέπει να ελέγξουμε και την παροχή 
της μάζας μας για να βεβαιωθούμε ότι διατηρείται. 
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Εικόνα 2.23: Ελεγχος μάζας ρευστού 

 

 

Εικόνα 2.24: Σύγκλιση λύσης 

 

 

 
∆ιάγραμμα 2.2: ∆ιάγραμμα υπολογιστικών επαναλήψεων 
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2.7 ΑΠΟΤΕΛΕΣΜΑΤΑ 

 

Παρουσίαση διανυσμάτων ταχύτητας: 

 

Εικόνα 2.25: ∆ιανύσματα ταχύτητας και υπολογιστικό πλέγμα 

 

Εικόνα 2.26: ∆ιανύσματα ταχύτητας 
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Η ταχύτητα μέσα στη στένωση παίρνει την μέγιστη τιμή 3.38682݉ ⁄ݏ , ενώ στα 
τοιχώματα είναι μηδέν. Επίσης παρατηρούμε ότι αμέσως μετά την στένωση 
δημιουργούνται ζώνες ανακυκλοφορίας της ροής. 

Αυτό μπορούμε να το εξηγήσουμε με βάση το θεώρημα της ορμής, έτσι 
λοιπόν εάν η πίεση σε έναν κλειστό αγωγό αυξάνεται κατά την διεύθυνση της ροής, 
ταυτόχρονα και με μεγαλύτερο ρυθμό αυξάνεται και το πάχος του οριακού 
στρώματος με αποτέλεσμα τα στοιχεία του ρευστού που βρίσκονται πιο κοντά στο 
τοίχωμα του αγωγού και επομένως έχουν μικρότερη κινητική ενέργεια να 
αναστρέφουν την κίνηση τους. 

Σαν αποτέλεσμα έχουμε την δημιουργία μίας περιοχής ανακυκλούμενης ροής 
και αποκόλληση του οριακού στρώματος από το τοίχωμα. 

 

 

Εικόνα 2.27: Φαινόμενο ανακυκλοφορίας ροής 
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∆ιάγραμμα ταχύτητας: 

 

∆ιάγραμμα 2.3: ∆ιάγραμμα ταχύτητας 

 

Παρουσίαση γραφήματος κατανομής πίεσης: 

 

Εικόνα 2.28: ∆ιάγραμμα κατανομής πίεσης 
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Εικόνα 2.29: Οψη αγωγού με την κατανομή της πίεσης και τα διανύσματα της 
ταχύτητας 

 

Η πίεση έχει στην είσοδο του αγωγού τιμή 5019.286 Pa μέσα στην στένωση 
μειώνεται και στην έξοδο μηδενίζεται. 

 

∆ιάγραμμα 2.4: ∆ιάγραμμα στατικής πίεσης 
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Το διάγραμμα κατανομής πίεσης συνάδει και με το γράφημα της 
βιβλιογραφίας όπως φαίνεται και παρακάτω: 

 

∆ιάγραμμα 2.5: ∆ιάγραμμα πίεσης συναρτήση της αξονικής απόστασης [4] 

 

 

Η πτώση πίεσης σε ευθύγραμμο αγωγό μπορεί να υπολογιστεί από τον εξής 
τύπο (εξ. Poiseuille) [7]: 

 dp = ଼ஜ୪୳ഥୖమ          (2.3) 

 

Όπου: 

μ: Συντελεστής ιξώδους 

l: Μήκος αγωγού 

R: Ακτίνα αγωγού. 

 

Εάν θέσουμε: 

μ=0.004 kg/(m·s) 

l=100mm 

R=10mm και  
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 ത=0.55 m/sݑ

 

Τότε έχουμε: 

݌݀	  = ଼∗଴.଴଴ସ௟௨ഥோమ ݀݌ = ଼∗଴.଴଴ସ∗଴.ଵ∗଴.ହହ଴.଴ଵమ ݀݌ = ଴.଴଴ଵ଻଺଴.଴଴଴ଵ =17.6 kg/(݉ݏଶ)=17.6Pa. (2.4) 

 

Έτσι λοιπόν παρατηρούμε ότι η στένωση παίζει σημαντικό ρόλο στην πτώση 
πίεσης αφού χωρίς στένωση, δηλαδή σε ευθύγραμμο αγωγό, η πτώση πίεσης θα 
ήταν 17.6 Pa ενώ με την στένωση 5019.286 Pa. 

 

Παρουσίαση γραφημάτος στροβιλότητας (vorticity): 

 

 

Εικόνα 2.30: Στροβιλότητα  

 

Η στροβιλότητα που παρουσιάζεται στον αγωγό έχει ελάχιστη τιμή 0.105 και 
μέγιστη τιμή 50744.656. 
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Παρουσίαση γραφήματος αριθμού Reynolds: 

Παρακάτω στην εικόνα 2.31 παρουσιάζονται οι αριθμοί Reynolds πως 
κατανέμονται καθώς και οι τιμές αυτών. Η ελάχιστη τιμή είναι 109.767 και η μέγιστη 
1489.641 που παρουσιάζονται στην είσοδο-έξοδο του αγωγού και στην στένωση 
αντίστοιχα: 

 

 

Εικόνα 2.31:Κατανομή αριθμών Reynolds 
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ΚΕΦΑΛΑΙΟ 3: ΕΠΙΛΥΣΗ ΤΗΣ ΠΑΛΜΙΚΗΣ ΡΟΗΣ ΑΙΜΑΤΟΣ ΣΕ 
ΠΡΑΓΜΑΤΙΚΗ ΑΡΤΗΡΙΑ 

 

 

 

Σε αυτό το στάδιο θα μοντελοποίησουμε την παλμική ροή αίματος σε αρτηρία 
η οποία ανακτήθηκε μέσω υπολογιστικής τομογραφίας CT Scan (Computer 
tomography Scan) μέσω του λογισμικού πακέτου Fluent. Ως παλμική ροή στη 
ρευστοδυναμική ορίζουμε την ροή στην οποία συμβαίνουν περιοδικές μεταβολές. 

 

 

3.1 ΜΟΝΤΕΛΟΠΟΙΗΣΗ ΤΗΣ ΠΑΛΜΙΚΗΣ ΡΟΗΣ ΣΤΟ FLUENT 

 

Για να μοντελοποιήσουμε παλμική ροή στο Fluent χρειάζεται να 
δημιουργήσουμε ένα αρχείο κειμένου που να περιέχει κώδικα γραμμένο σε γλώσσα 
προγραμματισμού (C++) το οποίο να ορίζει την χρονικά μεταβαλλόμενη πίεση. 

Η πίεση στην είσοδο θα προσεγγιστεί από μια ημιτονοειδή συνάρτηση, όπου η 
κυκλική συχνότητα του ορίσματος θα αντιστοιχεί στους σφυγμούς ενός μέσου υγιούς 
ενήλικα (72 παλμοί το λεπτό), ενώ το πλάτος θεωρείται το μέσο πλάτος της 
συστολικής πίεσης, 120mmHg. Η εξίσωση που θα περιγράψει την πίεση εισόδου 
είναι:  

P(t)= P0+15789.5*sin(7.5*t) 

όπου Po=101325 Pa η ατμοσφαιρική πίεση.  

Παρακάτω παρουσιάζεται ο κώδικας με τον οποίο ορίσαμε την χρονικά 
μεταβαλλόμενη πίεση. Ο τρόπος με τον οποίο έγινε η εισαγωγή είναι ο εξής: 

Ανοίγωντας το interface του Fluent επιλέγουμε: 

Fluent>Define>User Defined>Interpreted UDFs.>Επιλογή του αρχείου με τον 
κώδικα>Interpret 

Στην ουσία ζητάμε από το πρόγραμμα να διαβάσει το αρχείο κειμένου που 
δημιουργήσαμε και να το μετατρέψει σε συνάρτηση. 
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ΚΩ∆ΙΚΑΣ ΧΡΟΝΙΚΑ ΜΕΤΑΒΑΛΛΟΜΕΝΗΣ ΠΙΕΣΗΣ 

#include "udf.h" 

DEFINE_PROFILE(pres,thread,position) 

{ 

face_t f; 

real t=CURRENT_TIME; 

begin_f_loop(f,thread) 

{ 

F_PROFILE(f,thread,position)=101325.0+15789.5*sin(7.5*t); 

} 

end_f_loop(f,thread) 

} 

  

ΓΕΝΙΚΟΤΕΡΑ ΒΗΜΑΤΑ ΜΟΝΤΕΛΟΠΟΙΗΣΗΣ 

 

1. Εισαγωγή της γεωμετρίας στο ICEM CFD 

2. ∆ημιουργία του πλέγματος 

3. Ελεγχος του πλέγματος 

4. Εισαγωγή αρχείου UDF 

5. Ορισμός μοντέλου 

6. Καθορισμός υλικού 

7. Ορισμός των συνθηκών λειτουργίας. 

8. Επίλυση του προβλήματος παλμικής ροής 

9. Αποτελέσματα. 

 

3.2.1 Εισαγωγή της γεωμετρίας στο ICEM CFD 

Σε αυτό το στάδιο επιλέγουμε να επεξεργαστούμε την γεωμετρία μας στο 
πρόγραμμα ICEM CFD. To ICEM CFD είναι ένα λογισμικό το οποίο έχει σχεδιαστεί 
για να δημιουργεί και να επεξεργάζεται εξελιγμένης μορφής υπολογιστικά πλέγματα. 

Οπότε κάνουμε εισαγωγή του αρχείου γεωμετρίας. 
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File>Geometry>Open.geometry… 

 

 

Εικόνα 3.1: Interface ICEM CFD 

 

3.2.2 ∆ημιουργία πλέγματος 

 

Αφού έχει γίνει η εισαγωγή της γεωμετρίας είμαστε έτοιμοι να ορίσουμε τις 
παραμέτρους για την δημιουργία του πλέγματος. 

Mesh>Global mesh setup>Global mesh parameters>global mesh size>Apply… 

Σε αυτό το στάδιο επιλέγουμε το είδος του πλέγματος που θέλουμε να 
δημιουργήσουμε. 

Mesh>Compute mesh>Volume mesh. 

Επιλέγουμε να δημιουργήσουμε πλέγμα σε όλο τον όγκο της γεωμετρίας. 

Παρακάτω στην εικόνα 3.2 παρουσιάζονται οι καρτέλες για τις ρυθμίσεις του 
υπολογιστικού πλέγματος 



40 
 

 

α)     β) 

Εικόνα 3.2: α)Global Mesh Setup  β)Volume Mesh 

 

Παρακάτω στην εικόνα φαίνεται η μορφή του υπολογιστικού πλέγματος πως 
έχει διαμορφωθεί. 

 

Εικόνα 3.3: ∆ιαμορφωμένο υπολογιστικό πλέγμα. 
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3.2.3   Προεπιλογή λύτη 
  
 Σε αυτό το βήμα ορίζέται το πρόγραμμα επίλυσης.Στην ουσία ορίζεται ο 
τρόπος με τον οποίο θα γίνει η επεξεργασία της λύσης της μοντελοποίησης. 
Output > Solver Setup > Fluent_V6. 
Common Structural Solver > ANSYS. 
 

 
Εικόνα 3.4: Επιλογή λύτη 

 

3.2.4 Εισαγωγή και ελεγχος του αρχείου πλέγματος στο Fluent 
 
File>Export mesh>To Ansys. 

Έπειτα από την εξαγωγή του αρχείου από το ICEM CFD και την εισαγωγή του 
στο Fluent πρέπει να πραγματοποιηθεί ένας έλεγχος στο πλέγμα. 
 
3.2.5 Καθορισμός κλίμακας Scale Grid 
 

Θα προσδιορίσουμε τις μονάδες στις οποίες ανφέρεται το πλέγμα για 
αποφυγή τυχόν σφαλμάτων.  

 

 

Εικόνα 3.5: Κλίμακα πλέγματος 
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3.2.6 Έλεγχος πλέγματος 

 

Οπότε: Problem Setup > Mesh > Check. 

 

Εικόνα 3.6: Επιλογές στατιστικών στοιχείων και μορφοποίησης πλέγματος 

 

Στατιστικά στοιχεία της γεωμετρίας και του πλέγματος παρουσιάζονται στην εικόνα 
3.7. 

 

Εικόνα 3.7: Στατιστικά στοιχεία γεωμετρίας 
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3.2.7 Ορισμός παραμέτρων Λύτη Fluent 

 

Εδώ η μόνη διαφορά με την μοντελοποίηση της στένωσης που είδαμε στο 
κεφάλαιο 2 είναι ότι η παράμετρος «Time» δεν είναι σταθερή αλλά Παροδική 
(Transient) και αυτό οφείλεται στο ότι θέλουμε να μοντελοποιήσουμε παλμική ροή και 
όχι σταθερή ροή. 

 

 

Εικόνα 3.8: Ορισμός παραμέτρων λύτη 

 

3.2.8 Επιλογή μοντέλου ροής 

Επιλέγουμε προσομοίωση στρωτής ροής (Viscous-Laminar). 

Models > Viscous-Laminar-On 

 

 

Εικόνα 3.9: Μοντέλα Ροής 



44 
 

3.2.9 Ορισμός ιδιοτήτων ρευστού και αγωγού 

 

Materials 

 

Εικόνα 3.10: ∆ημιουργία ρευστού 

 

Θεωρούμε επίσης ότι ο αγωγός μας δεν έχει ελαστικότητα και δεδομένου ότι 
δεν θα συμμετέχει το τοίχωμα στην προσομοίωση, αφήνουμε το προεπιλεγμένο 
υλικό και σε αυτήν την περίπτωση (αλουμίνιο). Εδώ θα πρέπει να αναφερθεί πως 
στην περίπτωση μελέτης φαινομένων αλληλεπίδρασης τοιχώματος και ρευστού όπου 
οι ιδιότητες του τοιχώματος θα είναι σημαντικές (π.χ. ελαστικότητα, διάδοση 
θερμότητας) θα πρέπει να ορίσουμε και να εισάγουμε το κατάλληλο υλικό στον 
εξομοιωτή αν αυτός δεν υπάρχει ήδη στις βιβλιοθήκες των υλικών του ANSYS. 

Οπότε για το ρευστό μας (blood), ορίζουμε για την πυκνότητα και το μοριακό 
ιξώδες, αντίστοιχα: 

 Density: 1050 kg/mଷ. 
 Viscosity: 0.004 kg/m-s. 

Για το αγγείο: 
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Εικόνα 3.11: ∆ημιουργία υλικού αγγείου 

 

Density: 2719 kg/mଷ.  
 

3.2.10 Ορισμός συνοριακών συνθηκών Boundary Conditions 

 

Οι συνοριακές συνθήκες που θα ορίσουμε για την μοντελοποιήση μας θα 
αφορούν τέσσερις ζώνες. Την είσοδο του ρευστού στο αγγείο(Inlet),την έξοδο από το 
αγγείο (outlet), τα τοιχώματα του αγγείου (walls) και το ρευστό 
(int_created_material_6). 

 

 

Εικόνα 3.12: Ορισμός συνοριακών συνθηκών για κάθε ζώνη 
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3.2.11 Ορισμός συνοριακής συνθήκης εισόδου-Inlet 
 
Inlet >Type >pressure-inlet. 
 

 
Εικόνα 3.1: Επιλογή ζώνης 

 
Επιλέγουμε Edit για να ορίσουμε επιπλέον παραμέτρους. Πιο συγκεκριμένα θα 

ορίσουμε να χρησιμοποιεί για την ολική πίεση την συνάρτηση που ορίσαμε εμείς σε 
προηγούμενα βήματα και ο κώδικας της παρουσιάζεται στην παράγραφο 3.1.  

 

 

Εικόνα 3.14: Συνοριακή συνθήκη εισόδου 
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3.2.12 Ορισμός συνοριακής συνθήκης εξόδου-Outlet 
 

Outlet >Type >pressure-outlet. 
Επιλέγουμε Edit για να ορίσουμε επιπλέον παραμέτρους. 

 

 
Εικόνα 3.15: Συνοριακή συνθήκη εξόδου 

 

3.2.13 Ορισμός συνοριακής συνθήκης τοιχώματος-Walls 

Walls >Type >walls >Edit >Momentum… 

 

Εικόνα 3.16: Συνοριακή συνθήκη τοιχώματος 

Εδώ επιλέξαμε το τοίχωμα του αγγείου να είναι σταθερό (stationary Wall) και 
χωρίς ολίσθηση (No slip). 
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3.2.14 Ορισμός συνοριακής συνθήκης ρευστού int_created_material_6 
 

Οι ιδιότητες του ρευστού μας έχουν επιλεγεί σε προηγούμενο βήμα (3.7) 
οπότε δεν χρειάζεται να ορίσουμε κάποια επιπλέον παράμετρο. 
 
3.3 Καθορισμός κριτηρίου σύγκλισης(Convergence criteria) 
 

Solution > Monitors >Residuals-Print,Plot… 
Σύγκλιση των εξισώσεων τάξης 10ିସ. 

 
Εικόνα 3.17: Ορισμός κριτηρίου σύγκλισης 

 
3.4 Αρχικοποίηση Λύτη-Solution Initialization 
 

 

Εικόνα 3.19: Αρχικοποίηση Λύτη 
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3.5 Επίλυση-Solution 

Αρχικά πραγματοποιούμε έναν έλεγχο για τυχόν σφάλματα στην 
μοντελοποίηση μας μέχρι στιγμής. 

Solution >Run Solution Check case. 
 

. 
Εικόνα 3.20: Ελεγχος υπόθεσης 

 
Στη συνέχεια πρέπει να οριστεί η παράμετρος Time Step Size (η διάρκεια 

βήματος σε δευτερόλεπτα). Αρχικά οι υπολογισμοί πραγματοποιήθηκαν με Time 
Step Size=1 sec και Number of Time Steps=60 sec των οποίων τα αποτελέσματα 
φαίνονται στις εικόνες. Όμως για να έχουμε μεγαλύτερη ακρίβεια στους 
υπολογισμούς μας θέσαμε Time Step Size=0.1 sec Number of Time Steps=600 sec. 

Το δεύτερο και μικρότερο βήμα το επιλέξαμε για να ελέγξουμε την χρονική 
σύγκλιση της προσομοίωσης. Τα αποτελέσματα έδειξαν αμελητέες διαφορές μεταξύ 
των δύο προσομοιώσεων. 

Έπειτα πραγματοποιούμε τον υπολογισμό της μοντελοποίησης. 

 

 

Εικόνα 3.21: Εναρξη υπολογισμών 
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Παρακάτω στην εικόνα 3.22 παρουσιάζεται ένα στιγμιότυπο της οθόνης κατά 
την διάρκεια των υπολογισμών.Στα δεξιά παρατηρούμε το γράφημα του ισοζυγίου 
μάζας να λαμβάνει μια παλμική μορφή κατά την διεξαγωγή των υπολογισμών 

 

 

Εικόνα 3.22: Στιγμιότυπο υπολογισμων στο Fluent 

 

 

Εικόνα 3.23: Στατιστικά στοιχεία λύσης 

 

Η λύση μας συγκλίνει αλλά πρέπει να ελέγξουμε και την παροχή της μάζας 
μας για να βεβαιωθούμε ότι διατηρείται. 
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Εικόνα 3.24: Ελεγχος παροχής μάζας 

 

3.6 ΑΠΟΤΕΛΕΣΜΑΤΑ 

 

Παρακάτω στις εικόνες παρουσιάζονται τα αποτελέσματα για διάφορα μεγέθη 
για δύο διαφορετικές περιπτώσεις. Στην πρώτη περίπτωση τα αποτελέσματα 
προέκυψαν θέτωντας Time Step Size ίσο με 1sec και Number of Time Steps ίσο με 
60. Στην ουσία αυτό σημαίνει ότι το Fluent προσομοίωσε και υπολόγισε την ροή στην 
αρτηρία για 60 sec με βήμα 1sec. Για κάθε ένα δευτερόλεπτο το Fluent έκανε 
επαναληπτικούς υπολογισμούς υπολογίζοντας κάποια μεγέθη. Στην δεύτερη 
περίπτωση με σκοπό να έχουμε μεγαλύτερη ακρίβεια στους υπολογισμούς μας 
μειώσαμε το Time Step Size σε 0.1 sec και αυξήσαμε το Number of Time Steps σε 
600. Και σε αυτή την περίπτωση το Fluent θα προσoμοιώσει ροή για 60 sec. 

 

3.6.1 ∆ιανύσματα ταχύτητας 

 

Στις εικόνες 3.25 και 3.26 παρουσιάζονται τα διανύσματα της ταχύτητας και για 
τις δύο περιπτώσεις επίλυσης.Το ρευστό εισέρχεται από την αριστερή πλευρά  της 
αρτηρίας και εξέρχεται από την δεξιά.Η μορφή των διανυσμάτων έχει απεικονιστεί με 
την βοήθεια 3D κωνικών στοιχείων ενώ για λόγους καλύτερης απεικόνισης της ροής 
έχει γίνει απόκρυψη των τοιχωμάτων της αρτηρίας.Παρατηρούμε λοιπόν πως στην 
είσοδο της αρτηρίας η ταχύτητα έχει υψηλότερη τιμή σε σχέση με την υπόλοιπη 
αρτηρία όπως επίσης και μετά το σημείο διαστολής που παρουσιάζεται στην μέση 
της γεωμετρίας.Γενικά δεν παρατηρούνται  μεγάλες διακυμάνσεις στην τιμή της 
ταχύτητας κάτι το οποίο είναι αναμενόμενο για την συγκεκριμένη αρτηρία καθότι δεν 
παρουσιάζει μεγάλες ή απότομες μεταβολές στην διατομή της. 
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Εικόνα 3.25: ∆ιανύσματα ταχύτητας Time Step =1s και Number of Time Steps =60  

 

 

Εικόνα 3.26: ∆ιανύσματα ταχύτητας Time Step =0.1s και Number of Time Steps 
=600  

Στην εικόνα 3.27 και 3.28 παρουσιάζεται η κατανομή των διανυσμάτων της ταχύτητας 
για την είσοδο της αρτηρίας για τις δύο περιπτώσεις επιλυσης. 
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Εικόνα 3.27: Κατανομή διανυσμάτων ταχύτητας στην είσοδο της αρτηρίας. Time 
Step =1s και Number of Time Steps =60.  

 

 

Εικόνα 3.28: Κατανομή διανυσμάτων ταχύτητας στην είσοδο της αρτηρίας. Time 
Step =0.1s και Number of Time Steps =600.  
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Στην εικόνα 3.28 και 3.29 παρουσιάζεται η κατανομή των διανυσμάτων της 
ταχύτητας για την έξοδο της αρτηρίας για τις δύο περιπτώσεις επίλυσης. 

Αυτό που έχει ενδιαφέρον να παρατηρήσουμε είναι ότι κοντά στα τοιχώματα 
της αρτηρίας οι τιμές της ταχύτητας τείνουν να γίνουν μηδέν. Αυτό οφείλεται στην 
συνθήκη μη ολίσθησης την οποία έχουμε ορίσει για τα τοιχώματα της αρτηρίας που 
μοντελοποιούμε το αποτέλεσμα είναι το ρευστό να μην ολισθαίνει πάνω στα 
τοιχώματα, δηλαδή η σχετική ταχύτητα των πραγματικών ρευστών ως προς το 
στερεό τοίχωμα είναι μηδέν ή ισοδύναμα ότι η εφαπτομενική ταχύτητα κοντά στα 
τοιχώματα είναι μηδέν. 

Σε σύγκριση με την κατανομή των ταχυτήτων στην είσοδο του ρευστού εδώ 
παρατηρούμε ότι η ταχύτητα έχει χαμηλότερες τιμές. Η διαφορά στην τιμή των 
ταχυτήτων οφείλεται στην διαφορετική διατομή εισόδου και εξόδου. 

 

 

Εικόνα 3.29: Κατανομή διανυσμάτων ταχύτητας στην είσοδο της αρτηρίας. Time 
Step =1s και Number of Time Steps =60  
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Εικόνα 3.30: Κατανομή διανυσμάτων ταχύτητας στην είσοδο της αρτηρίας. Time 
Step =0.1s και Number of Time Steps =600  

 

3.6.2 Κατανομή πίεσης 

 

Εικόνα 3.31: Κατανομή πίεσης στην αρτηρία. Time Step =1s και Number of Time 
Steps =60  
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Εικόνα 3.32: Κατανομή πίεσης στην αρτηρία. Time Step =0.1s και Number of Time 
Steps =600 

 

Εικόνα 3.33: Κάθετη πίεση τοιχώματος 



57 
 

3.6.3 Κατανομή τάσεων τοιχωμάτων 

 

Παρακάτω παρουσιάζονται οι διατμητικές τάσεις στα τοιχώματα της αρτηρίας. 
Παρατηρούμε ότι δεν υπάρχουν περιοχές με ιδιαίτερα υψηλές τιμές διατμητικών 
τάσεων κάτι το οποίο είναι αναμενόμενο διότι δεν έχουμε και μεγάλες διακυμάνσεις 
στην πίεση. Γενικά η αρτηρία που προσομοιώθηκε έχει ήπια στένωση «Artery with 
mild stenosis» και συνεπώς δεν αναμένονται μεγάλες διακυμάνσεις στα πεδία 
πιέσεων και ταχυτήτων. Η συγκεκριμένη αρτηρία δεν έχει αθηρωματική πλάκα και η 
μελέτη γίνεται για δυνητική εμφάνιση ανευρύσματος σε περιοχές όπου εμφανίζονται 
ισχυρές τάσεις στα τοιχώματα. Γενικά περιοχές επικίνδυνες για αρτηριοσκλήρυνση 
(αθηρωμάτωση) είναι οι περιοχές χαμηλής διατμητικής τάσης (με σκούρο μπλε στις 
παρακάτω εικόνες. Πιο συγκεκριμένα οι φυσιολογικές τιμές κυμαίνονται από 5-20 Pa. 
Οι φυσιολογικές τιμές που έδειξαν τα αποτελέσματα δεν σημαίνουν απαραίτητα ότι 
δεν θα εχουμε και την εμφάνιση αθηρωματικής πλάκας καθότι οι παράγοντες που 
επηρεάζουν την δημιουργία της είναι αρκετοί. Αντίθετα ανεύρυσμα μπορεί να 
εμφανιστεί σε περιοχές του τοιχώματος με υψηλές κάθετες τάσεις (Εικ. 3.33).  

 

Εικόνα 3.34: Κατανομή τάσεων τοιχωμάτων στην αρτηρία. Time Step =1s και 
Number of Time Steps =60 
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Εικόνα 3.35: Κατανομή τάσεων τοιχωμάτων στην αρτηρία. Time Step =0.1s και 
Number of Time Steps =600 
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3.6.4 Κατανομή αριθμού Reynolds 
 

Παρακάτω στην εικόνα παρουσιάζονται οι αριθμοί Reynolds πως 
κατανέμονται καθώς και οι τιμές αυτών που κυμαίνονται από 0.1 έως 55 με τις 
μεγαλύτερες τιμές, όπως αναμενόταν, στις μικρότερες διατομές.  

 

 
Εικόνα 3.36: Κατανομή Reynolds. Time Step =1s και Number of Time Steps =60 

 

 

Εικόνα 3.37: Κατανομή Αριθμού Reynolds. Time Step =0.1s και Number of Time 
Steps =600  
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ΣΥΜΠΕΡΑΣΜΑΤΑ 

  

 

 

Στη συγκεκριμένη πτυχιακή εργασία προσομοιώθηκε και μελετήθηκε η ροή του 
αίματος σε πρότυπη αρτηρία από υπολογιστική τομογραφία [9] με τη χρήση του 
εμπορικού κώδικα Υπολογιστικής Ρευστοδυναμικής, Ansys Fluent. 

 Στο δεύτερο κεφάλαιο εξετάστηκε η περίπτωση μόνιμης ροής σε κυκλικό 
αγωγό με στένωση στη μέση. Το ρευστό που χρησιμοποιήθηκε για να 
μοντελοποιηθεί η ροή έχει πυκνότητα 1050 kg/m3 και ιξώδες 0,004 kg/(ms). Για τον 
σχεδιασμό της γεωμετρίας χρησιμοποιήθηκε το Design Modeler στη συνέχεια για 
επίλυση το Ansys Fluent και για την επεξεργασία των αποτελεσμάτων το CFD – 
POST. 

 Αναλυτικότερα παρατηρώντας τα διανύσματα της ταχύτητας όπως 
παρουσιάζονται στις εικόνες (2.25) (2.26) παρατηρούμε ότι στη στένωση έχουμε 
κατακόρυφη αύξηση της ταχύτητας που φτάνει την μέγιστη τιμή 3.419 m/s. 
Επιπρόσθετα λαμβάνοντας υπ’ όψιν και το διάγραμμα κατανομής της πίεσης, όπως 
φαίνεται στην εικόνα (2.28), παρατηρούμε ότι η τιμή της πίεσης μειώνεται κατά μήκος 
της γεωμετρίας, κάτι το οποίο συνάδει και με τη θεωρία μας. 

 Όσον αφορά λοιπόν τη μοντελοποίηση σε ιδανική αρτηρία μπορούμε να 
πούμε ότι η επίλυσή μας ήταν επιτυχημένη αφού τα αποτελέσματα που εξάγαμε 
συμφωνούν με τη θεωρία της ρευστοδυναμικής. 

 Στο τρίτο κεφάλαιο επιλέξαμε να προσομοιώσουμε και να μελετήσουμε 
παλμική ροή σε πραγματική αρτηρία ήπιας στένωσης. 

 Το υπολογιστικό πλέγμα δημιουργήθηκε με τη βοήθεια του ICEM – CFD το 
οποίο είναι ποιο εξειδικευμένο και με δυνατότητα εισαγωγής απεικονίσεων και 
σχεδίων, σε σύγκριση με το Design Modeler. Η επεξεργασία των αποτελεσμάτων 
έγινε με το CFD – POST. 

 Παρατηρώντας τα αποτελέσματα των διανυσμάτων ταχύτητας βλέπουμε ότι 
δεν αναπτύσσονται σχετικά μεγάλες ταχύτητες ροής στην αρτηρία. Το γεγονός αυτό 
οφείλεται στο ότι η αρτηρία δεν έχει έντονες μεταβολές στην διατομή της σε αντίθεση 
με τη γεωμετρία που εξετάσαμε στο 2ο κεφάλαιο. Επιπλέον εξετάζοντας και την 
κατανομή των γραφημάτων του αριθμού Reynolds παρατηρούμε ότι η ταχύτητα της 
ροής αυξάνεται στην είσοδο και στην έξοδο της αρτηρίας, ενώ παράλληλα οι τιμές 
του αριθμού Reynolds (0.1-55) επαληθεύουν τη στρωτή ροή που θέσαμε ως μοντέλο 
υπολογισμού. 
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Για περαιτέρω επαλήθευση του μοντέλου υπολογισμού που θέσαμε για στρωτή ροή 
έγινε και μία προσομοίωση με το μοντέλο k-ε, το οποίο χρησιμοποιείται για 
υπολογισμό τυρβώδους ροής και τα αποτελέσματα επαλήθευσαν την υπόθεση 
μας.Συγκεκριμένα η λύση  έδινε  αμελητέες διαφορές σε σχέση με τα αποτελέσματα 
για στρωτή ροή καθότι οι τιμές των μεγεθών για την δημιουργία τυρβώδους ροής δεν 
ήταν οι κατάλληλες. 

Μελετήθηκαν ακόμα και οι τάσεις στα τοιχώματα της αρτηρίας για να 
διαπιστωθεί τυχόν δυνητική εμφάνισης αρτηριοσκλήρωσης λόγω δημιουργίας 
αθηρωματικής πλάκας ή δημιουργία ανευρύσματος, ασθένειες πολύ επικίνδυνες για 
οποιαδήποτε ασθενή. Στην συγκεκριμένη αρτηρία όπως φαίνεται και από τις εικόνες 
της παραγράφου 3.6.3 δεν υπάρχουν ισχυρές κάθετες τάσεις (Εικ.3.33) για να 
δημιουργήσουν ανησυχία για ανεύρυσμα. Αντίθετα υπάρχουν 2 περιοχές χαμηλών 
διατμητικών τάσεων που ενδεχομένως και σε συνάρτηση με τις αιματολογικές 
εξετάσεις του ασθενή να εμφανίσουν αθηρωματική πλάκα. 

Συμπερασματικά λοιπόν τα αποτελέσματα που εξήχθησαν με τη βοήθεια του 
υπολογιστικού προγράμματος Fluent συνάδουν με τη θεωρία μας σε ικανοποιητικό 
βαθμό. Έτσι λοιπόν μπορούμε με ασφάλεια να πούμε ότι η χρήση εμπορικών 
πακέτων Υπολογιστικού Κώδικα αποτελεί ένα σπουδαίο εργαλείο στα χέρια της 
επιστήμης, όχι μόνο σε απλά προβλήματα ρευστοδυναμικής αλλά ακόμη και σε 
πολύπλοκα συστήματα με διάφορα είδη ροών και σύνθετης γεωμετρίας. Στο άμεσο 
μέλλον θα μπορούσε να χρησιμοποιηθεί ως εργαλείο διάγνωσης αγγειακού 
προβλήματος ή ακόμα και πρόληψης μιας αγγειακής πάθησης μελετώντας δεδομένα 
που προκύπτουν από μια υπολογιστική τομογραφία[9] χωρίς την ανάγκη 
επεμβατικών μεθόδων. 
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ΠΡΟΤΑΣΕΙΣ ΓΙΑ ΒΕΛΤΙΩΣΗ ΚΑΙ ΠΕΡΑΙΤΕΡΩ ΕΡΕΥΝΑ 

 

 

 

Με την ολοκλήρωση της πτυχιακής εργασίας θα είχε ιδιαίτερο ενδιαφέρον να 
παρουσιαστούν κάποια σημεία που θα μπορούσαν να διερευνηθούν σε επόμενες 
πτυχιακές εργασίες. 

Στο μοντέλο που χρησιμοποιήθηκε έγιναν κάποιες παραδοχές (π.χ.ανελαστικά 
τοιχώματα, φύση ρευστού) έτσι ώστε να μπορέσουμε να μελετήσουμε την 
συμπεριφορά του κάτω απο ορισμένες συνθήκες και να εξάγουμε αποτελέσματα. 

Μια πρόταση είναι η ίδια αρτηρία να μελετηθεί χρησιμοποιώντας ελαστικά 
τοιχώματα και να εξαχθούν αποτελέσματα για τις διατμητικές τάσεις που 
αναπτύσονται στα τοιχώματα. 

Επιπρόσθετα θα μπορούσε να μελετηθεί κάτω απο την επίδραση 
θερμοκρασιακών αλλαγών και να εξαχθούν συμπεράσματα για την διαμόρφωση της 
ροής βάση αυτών των αλλαγών. 

Μία άλλη πρόταση θα μπορούσε να είναι η μελέτη της αρτηρίας 
χρησιμοποιώντας ως είσοδο μια συνάρτηση ταχύτητας και να συγκριθούν τα 
αποτελέσματα με την συγκεκριμένη μοντελοποίηση που μελετήσαμε. 

Ως επέκταση του ροϊκού μοντέλου θα μπορούσε να θεωρηθεί και μια 
αυστηρότερη και ακριβέστερη προσέγγιση του αίματος ως διφασικό ρευστό και να 
εισαχθεί στον εξομοιωτή του Fluent. 

Κλείνοντας, μπορούμε να πούμε ότι υπάρχει σπουδαία προοπτική στην 
Υπολογιστική Ρευστοδυναμική με μεγάλη δυνατότητα βελτίωσης και χώρο για 
έρευνα, έτσι ώστε κάποια στιγμή να είμαστε σε θέση να χρησιμοποιούμε τα 
αποτελέσματα των μοντελοποιήσεων ώς κύρια μορφή διάγνωσης των 
καρδιαγγειακών προβλημάτων. 
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ΠΑΡΑ∆ΟΧΕΣ 

 

 

 

Για την επίλυση των παραπάνω προσομοιώσεων έχουν γίνει κάποιες 
παραδοχές. 

Οι παραδοχές αυτές παρουσιάζονται παρακάτω και επεξηγούνται οι λόγοι που 
εφαρμόστηκαν. 

Οι αρτηρίες και τα αγγεία λόγω της κυτταρικής δομής τους έχουν τη 
δυνατότητα να συστέλλονται και να διαστέλλονται. Η ελαστικότητα αυτή των 
αρτηριών επηρεάζει την συμπεριφορά τους σε πραγματικές συνθήκες ροής. Στην 
περίπτωση μας όμως λόγω του ότι μελετάμε την Νευτώνεια συμπεριφορά του 
ρευστού και κατ’ επέκταση την ροή και την επίδραση που έχει στην αρτηρία 
θεωρούμε τοίχωμα απαραμόρφωτο ,αδιαπέρατο και ακίνητο. 

Επιπλέον λόγω του ότι δεν μελετάμε το πρόβλημα με θερμοκρασιακές 
μεταβολές καθώς κάτι τέτοιο θα μετέβαλε τα χαρακτηριστικά της ροής μας θεωρούμε 
τις μεταβολές που συμβαίνουν ισόθερμες. 

  



65 
 

  



66 
 

 

 

 

 

ΒΙΒΛΙΟΓΡΑΦΙΑ 

 

 

 

ΕΛΛΗΝΙΚΗ ΒΙΒΛΙΟΓΡΑΦΙΑ: 

1. Αλεξανδρή Βασιλική «Υλοποίηση πειραματικής διάταξης υπολογισμού του 
καρδιακού ρυθμού χρησιμοποιώντας τεχνικές ψηφιακής επεξεργασίας εικόνας 
και βίντεο».Πανεπιστήμιο Πάτρας. Τμήμα Ηλεκτρολόγων Μηχανικών και 
Μηχανικών Υπολογιστών.Φεβρουάριος 2011 

 
2. Αγγελίδης Εμμανουήλ .«Υπολογιστική προσομοίωση της ροής στα στεφανιαία 

αγγεία βασισμένη σε πραγματικά ανατομικά δεδομένα», Μεταπτυχιακή 
∆ιπλωματική Εργασία.ΕΜΠ.Τμήμα Ηλεκτρολόγων 
Μηχανικών.Αθήνα,Οκτώβριος 2012 

 
3. Κυλιντηρέα Ηλιάνα-Σταματία.«Υλοποίηση πειραματικής διάταξης που θα 

χρησιμεύει στον υπολογισμό της ταχύτητας του αίματος του υπό εξέταση 
ασθενούς, χρησιμοποιώντας τεχνικές ψηφιακής επεξεργασίας εικόνας και 
βίντεο», ∆ιπλωματική εργασία.Πανεπιστήμιο Πατρών.Τμήμα Ηλεκτρολόγων 
Μηχανικών. Πάτρα, Σεπτέμβριος 2009 

 

4. Μπάκα Πανωρέα Γ.,., «Μοντελοποίηση της ροής του αίματος σε στένωση 
προκαλούμενη από περίδεση της πνευμονικής αρτηρίας», Μεταπτυχιακή  
∆ιπλωματική Εργασία, ΕΜΠ, Τμήμα Μηχανολόγων Μηχανικών. Αθήνα, 
Φεβρουάριος 2010 

 

5. Σιέγκας Λ.Πέτρος, «Υπολογιστική μελέτη μόνιμης και μη μόνιμης ροής σε 
στένωση αγωγού με αδιαβατικά και μη αδιαβατικά τοιχώματα», ∆ιπλωματική 
εργασία, ΕΜΠ, Τμήμα Μηχανολόγων Μηχανικών, Αθήνα 2007. 

 

6. Αιµοδυναµική της αρτηριοφλεβικής αναστόµωσης. Υπολογιστική 
προσομοίωση, Γ.Ν. Στεργιόπουλος, Εκδόσεις ΕΜΠ, Αθήνα 2007 

 
 



67 
 

 

7. «Σημειώσεις Εργαστηρίου Μηχανικής Ρευστών», Σοφία Κόττου, Επίκουρη 
Καθηγήτρια Ιατρικής Φυσικής, Ιατρική Σχολή Πανεπιστημίου Αθηνών. 

 

8. «Σημειώσεις Εργαστηρίου Μηχανικής Ρευστών», Τμήμα Μηχανολόγων 
Μηχανικών Τ.Ε., Σχολή Τεχνολογικών Εφαρμογών, ΤΕΙ ∆υτικής Ελλάδας. 

 

 
9. “Υπολογιστική τομογραφία αρτηρία ασθενούς (CT scan)", Γ. Καγκάδης 

Επίκουρος Καθηγητής, τμήμα Ιατρικής, Πανεπιστήμιο Πατρών 
 
 

10. «Σημειώσεις Εργαστηρίου Μηχανικής Ρευστών» Εργαστήριο Ιατρικής 
Φυσικής, Ιατρική Σχολή Πανεπιστημίου Αθηνών. 

 

ΞΕΝΟΓΛΩΣΣΗ ΒΙΒΛΙΟΓΡΑΦΙΑ 

 

11. Modeling Basic Fluid Flow, Fluent Documentation, User’s Guide. 

 

 

12. Alina G. van der Giessen,Harald C. Groen,Pierre-André Doriot,Pim J. de 
Feyter, Antonius F. W. van der Steen,Frans N. van de Vosse,Jolanda J. 
Wentzel, Frank J. H. Gijsen «The influence of boundary conditions on wall 
shearstress distribution in patients specific coronary trees.», Journal of 
Biomechanics 44, 2011, pp.1089–1095. 

 
13. Siouffi, M., Pelissier, R., Farahifar, D., Rieu, R., The effect of unsteadiness on 

the flow through stenoses and bifurcations, J Biomech 17:5 (1984) pp.299-
315. 



68 
 

 


